UNAUTHORIZED

THE GREAT MACINTOSH EASTER EGG HUNT

DAVID POGUE

GAMES! GRAPHICS! GOOFS!

BERKLEY
The Great Macintosh®
Easter Egg Hunt
Most Berkley Books are available at special quantity discounts for bulk purchases for sales promotions, premiums, fund-raising or educational use. Special books, or books excerpts, can also be created to fit specific needs.

UNAUTHORIZED
THE
Great Macintosh®
Easter Egg Hunt

David Pogue

BERKLEY BOOKS/NEW YORK
The Great Macintosh®
Easter Egg Hunt
The Birth of the Easter Egg

Consider the injustice: When you write a book, your name goes on the cover. When you write a newspaper article, your name goes at the top. When you write a movie, your name goes on the poster.

But when you write computer software—even if it's the best-selling program on earth—nobody knows your name. You don't get credited, no matter how important your contribution—not on the box, not on the startup screen, not in the manual. In most cases, no matter how talented you are, you get no credit at all.

Imagine how you'd feel if you had written, say, ClarisWorks, or System 7, or RAM Doubler—and yet you got even less billing than the screenwriter of Ernest Goes Shopping. You'd be hurt. You'd be outraged. You'd seek revenge.

In fact, you might vow to bury your name in the software itself. In your computer code, you'd plant a secret tribute to yourself: a movie, a photograph, a sound effect, or some other form of credit.
screen. You’d carve your initials into the wet cement of the new software. In computer industry lingo, you’d create an *Easter egg*.

**Why they’re hard to find**

Creating a software Easter egg is no easy task. Most software companies discourage such frivolous wastes of disk space, memory, and manpower. From the software company’s point of view, you *already* got your reward for your programming efforts—your paycheck. The corporation figures it ought to get the credit for the software, not the lowly geek who wrote the code. If the higher-ups find out you’ve planted an Easter egg, they’ll make you take it right out. Microsoft über-geek Bill Gates, for example, has explicitly stated that no individual programmer’s name will ever appear in a Microsoft program.

For the programmer, then, the object of the game is to *hide* the Easter egg so that only the most diligent hunters will uncover it; that, by the way, is why it’s called an Easter egg. Programmers design their secret surprises so that they’ll appear only if you press a certain combination of keys, click the mouse in a certain spot, type a specific phrase, and so on. The secrecy of these little buried treasures gives them an aspect of counterculture rebellion.
In recent years, Easter eggs have taken on a mythic importance. With each new release of Apple’s system software, for example, Macintosh fans pounce, fingers ready on the Option and Command keys, clicking madly, hoping to find the goodies buried there. And for their part, programmers have begun a silent competition: Who can write the coolest Easter egg?

The Macintosh computer has always been at the vanguard of graphics, sound, and movies—not to mention coolness in general. It’s no surprise, therefore, that many of the best Easter eggs are found in Macintosh software, lurking in the ordinary software you probably use every day.

About The Great Macintosh Easter Egg Hunt

The time has come to pay tribute, not just to programmers’ efforts at large, but to their efforts at creating Easter eggs. This book shows off the one hundred best Macintosh Easter eggs and reveals exactly how you can make them appear on your own screen.

Have fun making these secret displays dance across the monitor. But here’s hoping they’ll also earn your respect for the unbelievable hours of tedious, eye-straining, caffeine-guzzling effort that goes into writing a software program today—and make you
glad that a tiny glimmer of each personality found its way into the otherwise bland, corporate result.

Your Number, Please

If you've appreciated the tactical difficulties involved in slipping Easter eggs into software without your bosses knowing about it, then you can appreciate why each Easter egg generally doesn't survive beyond a single version of a program. Sooner or later, the program's fans unearth the Easter egg, and the software company's No Fun Committee insists that it be removed. Sure enough: In the next version of the program, the Easter egg is no longer there.

Fortunately, in most cases, some other Easter egg has taken its place!

The point is, though, that this book makes a big deal out of specifying the version numbers of the programs that harbor these mysterious software surprises. Now you know why: If you don't have exactly the right version, then the Easter egg might not even exist.
How to check the version of system software

To figure out what version of the Mac's own operating system (its System folder) is on your Mac, choose the About This Macintosh (or About This Computer) command from the Apple menu. In the dialog box that appears, you'll see the version number indicated like this:

(Actually, you don't really see big black arrows like that, but I'm trying to make a point here.)
How to check the version of other programs

OK, so that's system software. Here's how you find out the version numbers of everyday programs like ClarisWorks, WordPerfect, Photoshop, and so on.

Open the folder that contains the program in question. Click once on the icon for the program itself, as shown below at left. From the File menu, choose Get Info. The resulting window, as shown below at right, tells you the version number.
The Ten Best Easter Eggs of All Time

To make it into this chapter, an Easter egg must be more than some dinky little credit typed into an About box. We're talking interactivity! music! multimedia! These are the ones worth calling coworkers over to see, worth buying a Mac for, worth sharing with your grandkids. Invite some friends over for cocktails, flip the computer on, and let the hilarity begin.
As any professional Easter egg hunter knows, one of the most frequent hangouts for secret credits is the About box. Every Mac program has an About box; it's the info screen that appears when you choose the About command at the top of the Apple menu. For example, in Photoshop, the command says About Photoshop (and produces a screen of copyright information); in ClarisWorks, it says About ClarisWorks, and so on.

When the Macintosh debuted in 1984, the operating system itself—the Finder—had an About box. To gloat about the Mac's then unheard-of excellence at graphics, the programmers endowed the About box with a stylish black-and-white picture of the sun setting in Silicon Valley, with the programmers' names moving by quietly underneath.

Today, of course, the About This Macintosh (or About This Computer) command in your Apple menu is much less artistic, showing a bunch of memory specs and system information. But the original Silicon Valley credits screen lives on—you just have to know how to reveal it.
1. Hold down the Option key on your keyboard.

2. Pull down the Apple menu.
The usual About This Macintosh command now says About the Finder, just as it did in 1984.

3. Choose About the Finder.
Welcome to Silicon Valley! The mountainside's surface looks admittedly cowlike, with those patchy black areas, but hey—they're programmers, not artists. Besides, if you have Mac OS 8 or later, you get the full-color, computer-generated version.

The Arcade Game Nobody Knows

As the year 2000 approaches, software gets more sophisticated—and so do Easter eggs. Apple's programmers wouldn't be able to face themselves in the mirror each morning if the best they could create was a boring old black-and-white drawing.

When creating System 7.5, therefore, Apple's programmers
outdid themselves. This Easter egg only works if you're running System 7.5 (not later versions, such as System 7.5.1 or System 7.5.3).

1. **Choose Note Pad from the Apple menu.**
   Actually, you can open any “drag-and-drop savvy” program: SimpleText, Claris Emailler, ClarisWorks 4.0, and WordPerfect are some examples.

2. **Type the words secret about box. Don't use capitals.**

3. **Drag across the phrase to highlight it. Then point to the highlighted phrase and drag it out of the Note Pad window and onto the desktop.**
   If all goes well, your screen should now be filled with a game of Breakout, or Brickles, or Pong, or whatever they called it when you were growing up.

   The mouse moves the paddle; bounce the ball against the names of the System 7.5 programmers until all the “bricks” disappear. After you get rid of them all, a new wall appears—there are five levels in all. Click the mouse to return to your regularly scheduled workload.

   (If you can't get this to work, then you either don't have System 7.5, or you're missing the file called Clipping Extension.)
It's supposed to be in the Extensions folder inside your System folder. Reinstall your System software to get it back again.)

The Iguana-Spangled Banner

Just because the secret Breakout game disappeared from later versions of System 7.5 doesn't mean Apple's programmers lost their sense of what's really important in software design (namely, Easter eggs). In fact, System 7.5.2 through System 7.6 contain a multimedia Easter egg that puts that paltry Breakout game to shame.

You can only see this jaw-dropper if you have either (a) a PowerBook 5300 or later, or (b) any Power Macintosh except the 6100, 7100, or 8100.

1. **Choose Note Pad from the Apple menu.**
   As with the Breakout-game Easter egg, you may substitute any "drag-and-drop savvy" program for the Note Pad.
2. Type the words *secret about box*. Don't use capitals.
   If you read about the secret Breakout game, this all may be sounding distinctly familiar.

3. Highlight the phrase, and then drag it onto the desktop.
   The screen goes black. Thunder rumbles in the distance. Somewhere, a wolf howls.
   And then you see an incredible full-screen movie, featuring a flag waving over Apple's Cupertino headquarters.
   The words on the flag say "Iguana iguana powersurgius"—an inside joke if ever there was one. "Power Surge" was the code name for the PCI-slot Mac models; nobody knows what the iguana represents.
   By moving the mouse, you can change the direction of the waving flag. In fact, if you jerk the mouse up and down at the right side of the screen, you make it billow alarmingly toward you and away from you. Generate enough violence this way, and you can even make the flag break off its pole and go fluttering away to the ground, shrinking in the distance until it's just a tiny crumpled lizard logo on the grass.
   But what makes the Secret Iguana the best Easter egg of the year isn't just the breathtaking realism of the flag-flapping animation; it's also the number of secret features *within* this secret feature. For example, leave the flag flapping away for an hour or
so; the iguana will eventually be replaced by a photo of the programmers (System 7.5.2) or the Mac OS logo (System 7.5.3 and later).

Furthermore, regardless of your system version, you can produce special effects by pressing certain keys as you drag the *secret about box* phrase onto the desktop. (Press the key *after* you start dragging the phrase but before you release the mouse.) Hold down the P key to see, instead of the iguana, that photo of programmers (System 7.5.2) or the Mac OS logo (System 7.5.3 and later). Press Q to eliminate the photographic elements of the display, leaving only a ghostly red flag flapping in blackness.

The W key produces a pair of tiny coordinates (such as -184, 45) that continuously show the current pixel position of the mouse. (Up and to the right produces positive numbers.) The T key produces a counter that indicates how many frames per second you’re getting from your iguana-flag QuickTime movie—a good measure of your Mac’s speed. Finally, press the S key to omit the scrolling credits from the bottom of the display.

Bonus trick: You can hold down *multiple* keys to combine their effects. Press T and S, for example, to eliminate the credits and see your QuickTime frame rate.

When it’s all over, have fun throwing away the 10 million text clipping files you’ve created on your desktop.
Antler!

One of the best features of System 7.5 (and later) is Stickies, the amazing program (in the Apple menu) that simulates the actual sticky notes people have been slapping on their computer screens for years. Most people think that Stickies display only text; not so.

1. Choose Stickies from the Apple menu.
You should see a couple of pastel-hued square “sticky notes” appear on the screen.

2. Choose New Note from the File menu.
A new, empty sticky appears.

3. Type Antler! and press the Return key.

If you type Antler! exactly as shown, on a new note, the secret credits screen appears—yes, a stately moose. This Easter egg tells you that (a) Apple doesn’t always write its own software, and (b) the programmers were fans of Northern Exposure.
Disinfectant is a great anti-virus program; if you don't have it, you should. After all, it's free! (You can get it from America Online, the Internet, or your local user group.) Not only does it squash almost every Macintosh virus ever written, but it harbors a classic Easter egg.

1. Launch the Disinfectant program.

2. Choose About Disinfectant from the Apple menu.

Enjoy the smiling photo of programmer John Norstad. After a moment, you'll hear the theme song (Sousa's "Liberty Bell March") from the British comedy TV show Monty Python's Flying Circus. As the music plays, the names of the Disinfectant-squashable viruses pile up on your screen. At last, as the music reaches its tinny crescendo, a huge foot, exactly like the one on the TV show's opening credits, descends and squashes the names. (Don't ask where Norstad got that sound effect!)
The Easter Egg Hall of Classic Greats

As you can probably imagine, one of the rewards—and challenges—of Easter egg hunting is that they’re fleeting ... evanescent ... elusive. Just when you’ve cornered a masterpiece, it’s discovered and removed from the next version of the software; you’re left to gnash your teeth, sigh, and fondly remember the good old days.

Yet those classic eggs are too good to ignore. To honor the forgotten programmers who slaved over them, let us pay tribute in these little sidebar boxes called, of course, The Easter Egg Hall of Classic Greats.

The very first Macintosh Easter egg of all wasn’t, in fact, in software; it was in hardware. The original 1984 Macs carried the unmistakable signatures of their designers—literally. If you opened the case of the computer, you'd find, on the inside of the Mac’s plastic housing, the signatures of the forty-seven principal designers, scratched out in crisp raised plastic.

The tradition lived on through the next several Mac models: the Mac 512k, the Macintosh Plus, and the Mac SE. After that, the tradition died out, probably because there grew to be too many signatures to fit without enlarging the case to the size of a boxcar.
Embedding a photographic self-portrait in software is one of the classic grabs for immortality used by programmers. In the case of QuickTime, the digital movie extension file, all you have to do is press the magic keys to make the picture appear.

1. Make sure there's a file called QuickTime in your Extensions folder.
   The Extensions folder is inside your System folder.

2. Restart the Mac, holding down four keys at once: Command, Option, Q, and T.
   Short for QuickTime, get it?

   You can't miss the result: an enormous full-screen slide show of the programmers' mug shots, complete with their names displayed beneath. As though this parade of geeks weren't entertaining enough, a happy little melody plays along. (To hear the happy little melody, be sure your speaker is turned on, and make sure you have QuickTime 2.1 or later installed—or QuickTime 2.0 with the Musical Instruments file.)
The QuarkXPress Martian

To qualify for the Hall of Fame, an Easter egg must be more than a couple of programmer's names in an About box; this select group of Easter eggs demands a more multimedia approach. This classic easily qualifies—it's got animation, color, sound—and no programmers' names!

1. **Launch QuarkXPress (version 3.1 or later).**
   If you don't have a document on the screen, choose New Document from the File menu.

2. **Create an object box.**
   For example, click the tool on the palette that looks like an A in a square. Then drag the mouse diagonally in the main window to create a box.

3. **Press Command-Option-K (or, in version 3.3 or later, either Command-Option-Shift-K or Command-Option-Shift-Delete).**
   Out walks Quark the Alien, antennae focused, making clomping footsteps as he invades your document. As you watch,
he takes careful aim with his ray gun and blasts your picture or text box with his laser death beam. It shimmers with the heat of the radioactive beam, quivers in its throes of agony, and finally—along with the alien—vanishes into oblivion.

It's only right that QuarkXPress should contain a doozy like this; after paying for an $800 program, you’re entitled to an $800 Easter egg.

Photoshop's Belching Cat

As you’ll discover in Chapter 6, Photoshop is crawling with little baby Easter eggs. Photoshop 4 offers just about the gnarliest secret About box of any program.

1. While pressing the Command key, choose About Photoshop from the Apple menu.

Here’s the secret Big Electric Cat. But it’s not just any cat.
2. While pressing the Command key, click the Big Electric Cat's nose.

Mr. Cat's little mouth drops open, and he treats you to the most resonating, gurgly audio burp in all of Easter egg-dom.

Gross!

---

The Illustrator Almanac

As with the Quark alien, the Adobe Illustrator Almanac is particularly notable because it doesn't exist for the usual Easter egg reason (programmer self-advertising). Instead, this one exists purely for entertainment. To make it work, you need Illustrator 5.0 or later.

1. Locate the information strip at the lower left corner of your document window.

If you click on this strip—which normally displays the name of the currently selected tool on the palette (such as "Selection Tool")—you'll see a list of useful info tidbits that will appear in the information strip. For example, choose Date and Time to make the info strip display the current date and time; Number of Undos
shows how many of Illustrator's multiple-Undo feature you've used up; and so on.

2. **While pressing the Option key, click on the info strip.**

This time, when the menu pops up, you'll see seven surprising new possibilities listed. Peter's Home Number, one hopes, has been changed since the program first appeared. Poor guy. Eyes puts a pair of hilarious eyeballs into the info strip that follow your cursor wherever it may go. Moon Phase tells you the current phase of the moon in the U.S. Mouse Clicks tells you how many times you've clicked your mouse since launching the program (useful primarily for making bar bets). The next option, National Debt, is especially terrifying because it's continually updated. So is the Random Number generator. After tracking the national debt, the only way to cheer yourself up is the final option: Shopping Days 'til Christmas!

---

**The Real Conflict Catcher**

Conflict Catcher, of course, is the award-winning troubleshooter and extensions manager from Casady & Greene. Even if you don't own it, you can experience the overpowering rush of the follow-
ing Easter egg—just get the free three-day demonstration version from America Online or the Internet.

1. From your Control Panels folder, open Conflict Catcher.
   As a shortcut, you can also choose Open Conflict Catcher from the little “CC” menu that the program puts on your menu bar.

2. Click the version number in the lower right corner.
   Yes, you’ve just uncovered the secret credits screen—but the fun is just beginning.

3. Type the word play and press Return.
   Yes, kids, it’s—Extension Invaders!

Suddenly, Mr. Logo Man evaporates. In his place is a game of Space Invaders—except that the bombs dropping onto your territory aren’t aliens . . . to make the symbolism juicier, they’re your extension icons, the ones in your System folder at the moment!

Your job is to blast them out of the sky. Use the arrow keys on your keyboard to move the cannon (the little Conflict Catcher icon at the bottom); fire your cannon by pressing your Space bar.
The better you perform, the higher your score goes.

If an invading extension reaches the bottom of the screen, you lose the round. You have to start a whole new game by entering the secret Easter egg world again as described above.

Click the mouse when the boss walks by and you need to return to your spreadsheet.
The Mac's famous operating system wasn't written in a day, and it wasn't written by one programmer, either. It's a patchwork quilt, each square contributed by a different software prodigy. Nowhere are the quilt squares more easily distinguishable than in your Control Panels folder (which you can open from your Apple menu).
Here, arrayed before you, are dozens of different mini-programs, each by its own mini-author, complete with its own mini-Easter egg. Double-click, man your Option key, and enjoy.

**After Dark**

After Dark, the popular screen saver, doesn't do for Easter eggs quite what it did for flying toasters. Still, there are a couple of screens in version 3.0 that you might not otherwise notice.

1. **Click the After Dark logo.**
   
   You get the first secret screen, complete with scrolling credits. They get more amusing the longer you wait.

   Also take note of the strip at the bottom of the After Dark control panel's window—where you see the copyright info. Click on this screen to read about the special features of each particular After Dark module—only there, for example, would you learn that the Caps Lock key makes your fish scatter as though they'd seen a shark.
AutoRemounter

Some Easter eggs don't blow your hair back with sound and light . . . but it's nice just knowing they're there. This baby egg lives in a control panel designed primarily for PowerBook laptops that live on networks. Ready? Hold on tight:

1. Option-click the version number.
A little credits screen appears. Ta-da!

Cache Switch

You don't have this control panel at all unless you have a Quadra, Centris, or other several-years-old Mac—specifically, one that's equipped with a “68040 processor.” Even if that's your Mac, there's only about one reason you'd ever want to open this control panel, and it's to do this:

1. Option-click the version number.
The little “040” icon slides over, revealing the name of the programmer. Isn't that cute?
Now we’re talking. This control panel’s primary function in life is to let you choose the color of the “highlighting pen” the Mac uses when you select some text (and the color of window borders). For the elite few who understand the importance of Easter eggs, however, the following function is far more entertaining.

1. Click where the words Sample Text appear. Hold the mouse down.

With each click, the words Sample Text change to say by Dean Yu and & Vincent Lo. Yes, that’s cool. But it’s only the beginning.

2. Click 15 more times.

At click number 16 (again, you need to keep your mouse button pressed), a surprising new name appears: Don Louv, the mysterious third programmer. But wait, the hilarity still isn’t over:

3. Click 26 more times.

At click number 42 (counting from when you began this exercise), a startling new expression appears in the little sample-text box: doodle doodle dee. And then:

4. Click 42 more times.

At click number 84, the final surprise of the evening: the The Great Macintosh Easter Egg Hunt
words *wubba wubba wubba* appear. Believe it or not, *doodle doodle dee* and *wubba wubba wubba* were phrases that flew across the very first TV ad for MTV, years ago. Do you suppose the programmers were getting just a *little* slaphappy?

## Control Strip

Actually, there have been two Control Strip control panels. The first was available only on PowerBooks. Today's Control Strip can work on any Mac using System 7.5.3 or later.

1. **Open your Control Panels folder (choose its name from the Apple menu).**
   
The Control Panels window opens.

2. **Find the icon called Control Strip; double-click it.**
   
The actual Control Strip window opens (don't confuse this control panel with the actual control *strip* that floats on your screen at all times).

3. **Option-click the version number.**
   
   If you have the 1995 PowerBook version, you'll see the author's secret credit appear.
4. If nothing happened, Option-click inside the Current Hot Key box.

In this case, you probably have the System 7.5.3 version; when you Option-click inside that little rectangle, the programmer's name appears in the title bar of the window!

Date & Time

In some control panels, it'd be a little too brazen to stick the programmers' names into the software—but as System 7.5's (and later ones) Date & Time control panel demonstrates, there are other ways for them to put their stamp on their work.

1. **Open the Date & Time control panel.**
   This panel, by the way, is how you change your Mac's clock.

2. **Click the Set Time Zone button.**
   Up pops a list of 180 major world cities, each in an immediately recognizable world time zone. You're supposed to use this list to help your Mac understand where in the world you are (it's easier to choose a nearby major city than to type in "Greenwich Mean Time minus 5 hours").

3. **Type the letter L.**
Correction: It's a list of 178 major world cities. Among the L's, you'll discover two cities that are distinctly not major: the tiny, utterly obscure Lower Burrell, Pennsylvania, and Lake Nebagamon, Wisconsin—the only cities in the entire list whose countries aren't listed. Can you say "programmers' home towns"?

See "Map," later in this chapter, by the way, for more on the Lower Burrell mystery.

**Extensions Manager**

Extensions Manager, unique to System 7.5 and later, is a great troubleshooting tool; it's used to turn on and off all your extensions (the little add-on features whose icons march across the screen when you turn the computer on every day).

1. **Click the version number.**
   So that's who wrote it!

**Labels**

When you turn on any System-7-or-later Macintosh, one of the menus at the top of the screen is called Labels. It's used to "tag"
selected files or folders with identifying labels (such as Back This Up).

The purpose of the Labels control panel, however, is to change the text of the labels. Instead of going through life with choices like Essential, Hot, or In Progress, you can make your Label menu offer choices like Pointless, Trash Immediately, or Ex-Wife's Stuff. Or . . . this:

1. Open your Labels control panel. Delete all seven existing text phrases.

That is, press the Delete key to nuke the first label item. Press the Tab key to jump into the second slot, and press Delete again. Repeat until you've made the control panel completely blank. (This control panel doesn't come with Mac OS 8 or later.)

2. Close the control panel window.

3. Choose Restart from your Special menu.
This action will, of course, restart your computer.

When the computer wakes up again, and your desktop returns, have a look at your Labels menu. Even though you distinctly remember making those labels blank, the menu is suddenly filled with new labels, each a single letter long. From top to bottom, they read A L A N J E F.
You don't suppose Alan and Jef could be programmers' names, do you?

Ah, the Launcher—the control panel that puts a big pane full of E-Z Launch icons on your desktop. One click launches whatever favorite files, programs, or folders you put there. And one click in just the right place does something more.

1. While pressing the Command and Option keys, click in the gray area between rectangular buttons at the top of the Launcher window. The picture above shows where you can click.

And, by the way, if you have no rectangular buttons at the top, do this: (1) Open your System folder. (2) Open the Launcher Items folder inside. (3) Choose New Folder from the File menu. (4) Create a name for your new folder that begins with a bullet (•) symbol, which you make by pressing Option-8. Now return to your desktop; your Launcher now has buttons at the top!

Anyway, once you click between the buttons, the secret credits panel appears.
Incidentally, while not exactly an Easter egg, there's also a secret Launcher feature that feels like one. Press Command and click the mouse—and keep the button down—anywhere in the colored portion of the window. You get a hidden pop-up menu that lets you change the size of your icons. How did we live before we had this?

**Map**

The Map . . . ah, the Map! This oft-overlooked masterpiece is literally seething with Easter eggs—it's a veritable Easter eggathon. Try these out for size:

1. Type *mid* into the Find box and press Return.
   
   Yep, you’ve found it, flashing out in the middle of some vast bleak expanse of ocean: the Middle of Nowhere. (Try typing *Mount* for another surprise.)

2. Type *low* and press Return.
   
   Yes, kids, it’s the return of Lower Burrell, PA, the statistically insignificant city that made its debut in the Date & Time control panel described earlier in this chapter. As you can probably guess, typing *lake* and pressing Return uncovers the other programmer’s hometown, Lake Nebagamon, Wisconsin.
3. Click the version number, just below the map picture.
   It's the programmer's name. Wonder if he's from PA or WI?

4. While pressing the Option key, click the Find button repeatedly.
   Hey, it's *Around the World in 80 Clicks!* You're shown every single city in the Map's internal atlas. Keep clicking on past Zurich, and you start the alphabet over again—but this time the cities appear in the native languages spoken there!

---

**Memory**

You can well imagine that, after spending months hunched in front of glowing terminals, programmers can get pretty goofy. They develop their own nicknames, inside jokes, and slang. Want a list of them? Try this in System 7 through 7.5.5.

1. Open the Memory control panel.

2. Where it says Virtual Memory, click On.
If you don't have a Virtual Memory switch, you probably have an older Mac (such as an LC) that doesn't offer this feature; alas, this Easter egg is beyond your Mac's reach.

3. While pressing the Option key, click the pop-up menu called Select Hard Disk.

Up pops the secret menu nobody was supposed to see, listing the names of Apple's memory programmers! Each name features a pop-out submenu containing his nicknames and inside jokes associated with him. Some of them really make you wonder . . .

I don't know about Mr. Sam, but I think I'd encourage the cultivation of other nicknames. Commander in Cheese . . .?

Monitors

Kids in their twenties subsisting on pizza and Coke and working single-mindedly for hours writing computer code may develop more than warped inside jokes; they may even begin to lose their identities, as this touching Easter egg so clearly illustrates.
1. **Open your Monitors control panel. Click the version number in the upper right corner.**

   Along with the list of programmers, you get a return of the wacky sticking-its-tongue-out icon that made its debut in the Scenic Silicon Valley Easter egg of Chapter 1.

2. **Press the Option key twelve times.**

   As you press Option for the twelfth time, something odd begins to happen: The first and last names begin to get randomly shuffled among the personnel. Continue tapping Option, and something else peculiar occurs: Among the names, the words *Blue* and *Meanies* become part of the muddle (producing such fascinating potential character-in-a-novel combinations as *Meanies Von Brink* and *Blue Puckett*). Adding to the hilarity, a few other, unauthorized names slink into the fray (such as KON and Eric3)—and that's when names start showing up in *colors*.

---

**Power Macintosh Card**

The tragedy of this Easter egg is that so few will ever see it. You can only get to it if you upgraded an older Mac by installing a Power Mac Upgrade Card. Still, if you're among the lucky ones, read on.
1. Choose Control Panels from the Apple menu. 
The Control Panels window appears.

2. While holding down the Option key, double-click the Power 
Macintosh Card icon.  

Et voilà: Instead of the usual control panel, you get a photo of 
the programmers! But it's not over yet:

3. From the ? menu at the upper right of your screen, choose 
Show Balloons. Use your cursor to point at each person's mouth in 
the photo.

Incredibly, the little pop-up balloon will make each programmer's mouth "say" an introduction and a witty remark. One of my 
favorites: "Hi, I'm Erica. Do you want to buy any Girl Scout cookies?"

My personal fave, though, is the guy wearing glasses and a 
blue shirt. The balloon coming out of his mouth says, "Top 5 rea-
sons Apple should move to Texas: 5) Don't have to be an Apple 
CEO to afford a house. 4) Most Texans don't live in Williamson 
County. 3) Texans don't place 'The' in front of highway names. 2) 
Blue Texas sky, hot Texas summers. 1) Real Mexican food."
PowerBook Setup

A baby egg: Option-click the version number to see the secret credits screen.

QuicKeys Keeps Going, and Going . . .

This handy mini-movie was born in version 2 of QuicKeys, CE Software's handy macro utility program. As Easter eggs are wont to do, however, it disappeared when version 3 was unleashed—only to resurface in a different software position.

1. Open the QuicKeys control panel.
   Either choose QuicKeys from your Apple menu, or choose Control Panels from your Apple menu (and then double-click the icon called QuicKeys).

2. Click the word QuicKeys (the logo). If you're using version 3, now click the Credits button.
   Wait long enough for the credits to scroll completely by, and the thudding of a bass drum will fill the air—the unmistakable harbinger of the Energizer bunny, who shortly appears, marching across the screen in cartoon form, banging that silly drum.

QuicKe$ (It may be in your Apple Extras folder.)
Sound

Every Mac on earth has a control panel called Sound. (It may be in your Apple Extras folder.) Only those equipped with System 7.5 through 7.6 (or System 7.1 with an extension called Sound Manager) will be blessed with this audio Easter egg.

1. Open the Sound control panel.
The panel opens; note the pop-up menu at the top left.

2. While pressing the Option key, choose any of the commands from the pop-up menu.
You hear a voice say "Wooowwwww," sounding like a programmer who's either narcotics-impaired or pretending to be. On the screen: a quote from philosopher Karl Jung.

WindowShade

Here's another baby egg for users of System 7.5 through 7.6 (you alone have the WindowShade control panel).

1. Open WindowShade.
2. Click the picture of the mouse button.
The secret credits screen appears.
Control panels alone, such as those described in the previous chapter, do not an operating system make. It's certainly more difficult to plant an Easter egg into an area of the Mac's software code than to plant it in a distinct control panel, but it can be done—as these clever eggs reveal.
Mac OS 8's Magic Box of Crayons

By the end of 1997, Easter eggs had become such a tradition at Apple that the company actually set up an official approval and testing process for them. In a quest for operating-system stability, there were to be no more unauthorized Easter eggs—only fully tested and debugged ones. Can't you just see the T-shirts? “Apple Computer: The Best Damned Easter Eggs in the World.”

This new policy explains why so many of the Easter eggs described in Chapter 2 are missing from Mac OS 8. Still, this newer operating system has a few officially approved tricks of its own, as you can find out for yourself if you’ve got Mac OS 8 or later.

1. From the Edit menu, choose Preferences.
   A dialog box appears, listing the Mac's file-label tags (“Essential, Hot, In Progress,” and so on) and their corresponding color swatches.

2. Click a color swatch.
   Yet another dialog box appears. The icons at the left side let you choose from among several different color-selection schemes. If you were to click the Crayon Picker, you’d see a picture of a box
of Crayolas. You could click each crayon to see its color name: “Chalk,” “Tangerine,” and so on.

But don't do that yet. Easter egg first!

3. **While pressing the Shift key, click the Crayon Picker icon.**

You get the box of crayons, all right. But this time, if you drag your cursor across the various crayon tips, you'll see the programmers' names, one per crayon.

![Crayon Picker](image)

Some of the crayons just say “Color Picker 2.1” (or whatever the version number is); but others offer more intriguing labels,
such as "Yes, I Surf Ohio" and "Night Thigh Desire." Man. Do these guys need to get out more, or what?

But wait, we’re not done with the Crayon Picker Easter eggs.

4. Close the Color Picker and the Preferences window. From your Apple menu, choose Control Panels. Double-click the one called Date & Time. Set your clock to some time in the future. Close the window, and repeat steps 1 and 2.

Beginning January 2, 1998, a funny thing starts happening to the crayons in the Crayon Picker: *Their tips start wearing down!*

On January 2, 1998, only the black crayon shows signs of overuse (just as with real crayons, right?). By 2004, nearly every other crayon is worn down. Zoom ahead 10 more years, and hey, it's time for a fresh box of crayons.

Or a new computer, anyway.
Peter, Mark, and Sam

Millions of Mac fans know all about pressing the Command and Option keys while the Mac is starting up: That's the trigger for "rebuilding the desktop file," a fundamental troubleshooting technique. Few, however, stop to smell the Easter eggs along the way. (This Easter egg doesn't work in Mac OS 8 or later—alas.)

1. Turn off the Mac. Turn it back on, but keep the Command and Option keys pressed.
   After about a minute, a message appears on the screen: Are you sure you want to rebuild the desktop file on Macintosh HD (or whatever your hard drive is called)?
   At this point, most people either click OK or Cancel, never suspecting that there's an Easter egg to be discovered.

2. Pull down the Apple menu.
   Although it's "grayed out," or dimmed, you might notice something peculiar. Instead of the usual assortment of Apple menu items, nothing appears now but a single letter p!

3. Check out the File and Special menus, too.
   At the very bottom of each of these menus is another single initial: m and S. We can only hope that p, m, and S are the first initials of the programmers.
4. While you're at it, try the Label menu.

Lo and behold: It's the return of our friends Alan and Jef, who previously starred in the Labels control panel (Chapter 2).

Now that you're here, by the way, you may as well click OK and let the Mac rebuild its desktop file—a good exercise every couple of months anyway.

QuickDraw GX

QuickDraw GX is not something most people install, let alone comprehend. Still, it comes with every copy of System 7.5 through 7.6, and it harbors a couple of sensational Easter eggs. It's perfectly reasonable to install QuickDraw GX from your system CD-ROM (or floppies) just to enjoy these goodies—and then uninstall QuickDraw GX after you've enjoyed them. (You can uninstall it using the same Installer you used to install it—just choose Remove from the Easy Install pop-up menu.)

1. If you don't see a printer icon on your desktop, such as LaserWriter GX or StyleWriter GX, open the Chooser. Click your printer model's icon on the left side, and click Create on the right side.

When it's all over, you'll see a printer icon on the right side of your screen. Its name ends in GX. (This, incidentally, is one of the purposes of QuickDraw GX; now you can print some-
thing just by dragging its icon **onto** your desktop printer icon.)

2. Highlight your desktop printer icon. Now, while pressing Command, Shift, and Option together, choose Open from your File menu.

Now *that's* what I call an Easter egg: color, scrolling credits, and extremely cool animation. Click when you're sick of it.

3. Easter egg #2:
Open your hard drive.
Open your System folder.
Open your Extensions folder.

Inside, you'll see all your extension icons; among them is one called QuickDraw GX.

4. Drag the QuickDraw GX icon directly out of its folder and onto your desktop printer icon. Turn on your printer and stand back.

Hey, look—it's the first *printed* Easter egg!

Actually, it's a full-page printout (in color, if your printer does color) listing all the programmers. (Wow, what a huge staff for a technology nobody even uses . . . )
Eggs That Never Were

Not every Easter egg sees light of day. Apple programmer Greg Marriott tells of a killer one that was intercepted by his superiors . . . and how he got his revenge.

A short time after I joined the Blue Meanies [Apple’s elite System 7 programming team], we started making plans for a secret About box in System 7. It was my job to figure out how to trigger it, what it should contain, and how to hide it in the sources so nobody at Apple would get wise before it was too late to stop us.

I talked to a few other Meanies, and we came up with a pretty good scheme. The trigger was full of sevens. If there were seven windows with titles having seven letters, and a user chose the seventh menu item in a menu, and that item was currently disabled, then the secret About box would appear. The
picture was encrypted, and the decryption key was assembled in pieces by the various triggers throughout the toolbox. I did that so if someone ran across the strange-looking code in the System file they still couldn’t see what was in the picture. It was cool!

Unfortunately, it had a bug. It crashed a program, and we got caught. A couple of engineers were trying to figure out why this application started crashing, and they backtracked right into our triggering code. It didn’t take long for the word to spread, and pretty soon we were in really deep s—-. I was ordered to remove it from the system.

I complied, of course, but probably not in the way the order-giver intended. I removed all of the triggers, but I left the picture in the System file. So if you’ve got a copy of 7.0 or 7.0.1, there’s a Blue Meanie secret About box lurking around in your System file, with no way to trigger it.
The AppleScript Editor, preinstalled on every Mac sold in the last few years, isn't something you probably use every day. In fact, it's probably something you never even knew you had.

But once you experience this multifaceted Easter egg, you may never leave it alone!

1. **In the AppleScript Editor program, choose About Script Editor... from the Apple menu.**

   A perfectly normal About box appears, complete with a perfectly normal Credits button that makes another perfectly normal dialog box appear.

2. **While pressing the Control key, click the program icon at the left side of the box.**

   Welcome to... **Guava Surprise (?).**

   If you click the Credits button now, you get a secret alternate Credits screen, complete with a quote worth taking to heart: “Time is just Nature's way of keeping everything from happening at once.”
But I promised you a multifaceted Easter egg, and multifaceted you shall get.

3. Click OK. This time, from the Apple menu, choose About AppleScript.
   Another perfectly normal About box appears.

4. Once again, Control-click the picture of the program icon.
   Pure Guava.
   Should we tell the programmer that guava means “a shrub of the myrtle family, widely cultivated for its sweet acid yellow or pink fruit”?

The Power Mac 7200 CD Egg

One reason very few Easter eggs take the form of movies that start playing before your very eyes is that, when stored digitally, movies take up a huge amount of disk space. The programmers would have a hard time concealing a secret movie in, say, SimpleText if the program suddenly ballooned to fifty megabytes in size.

If you’re the creator of a CD-ROM, however, it’s a different story. You can easily conceal a movie somewhere on the CD’s almost limitless silvery tracks, and nobody will be the wiser. For
proof, consider the CD-ROM disc that came with Power Macintosh 7200/75 or 7200/90 models.

1. **Insert the System 7.5.2 Software that came with your Mac.**
   Its icon should appear on your desktop.

2. **Launch SimpleText**
   You can use any copy of SimpleText—a copy on the CD you just inserted, or on your hard drive, or wherever you can get it. (Use your Find command, in the Apple menu, if you’re having trouble finding a copy.) Actually, any movie-playing program (including the MoviePlayer, Microsoft Word, ClarisWorks, or whatever) will work for this.

3. **From the File menu, choose Open.**
   Now you’re going to navigate your way into the secret folder on the Software CD.

4. **Click the Desktop button.** Open the System 7.5.2 Software CD icon. Open the Apple Extras folder. Open the QuickTime Extras folder. Open the Movies folder, and then the Photos folder. Finally, open the file called 7200 QCRM Movie.
   A movie starts playing on your screen. Hey—it’s Apple’s 7200 testing team in Ireland! Talk about going right to the source . . .
The Quadra AV CD Egg

This secret movie is accessible only to a chosen few: those with a Quadra (or Centris) 660AV or 840AV. It works exactly like the 7200 CD egg described above, and you get to it the same way, except that, of course, you use the CD-ROM disk that came with your model. And in step 4, you navigate like this:

4. Click the Desktop button. Open the Quadra AV Software CD icon. Open the System folder. Open the Preferences folder. Finally, open the file called Our Gang.

Your reward is a long QuickTime movie—five minutes of the programmers horsing around on the last day of work before shipping the Quadra AV.
Apple's original definition of "speech recognition" was a fairly loose one. As provided in the original speech-savvy Mac models, the Quadra 660AV and 840AV, it could only understand a few things you said into the microphone. For example, you could say, "Computer, what time is it?" And it would say, in an accent sounding like a slightly tipsy Norwegian, "Ten-fifty-three P.M." (The first-generation Power Macs, such as the 6100, 7100, and 8100, also offered this feature.)

Actually, there were several other utterances those AV models (the software was called PlainTalk 1.2) could understand—but they were secret. For example, you could say, "Are there any Easter eggs?" And the Mac would say, "If there were, do you think I would tell you?"

You could also open the Speech Setup control panel and say, "Did anyone test you?" The answer would come: "Of course! I was tested by 'Braz' Ford and Morgan Wise." And if you said, "I need help," the reply would be "I'm sorry, they did not have time to add my artificial intelligence module."

Unfortunately, when it came time to create subsequent versions of the PlainTalk software, they left out more than the artificial intelligence module; they took out all of these fun Easter eggs, too.
The Voices Inside Your Mac

Apple may have squelched most of the personality out of the early PlainTalk (speech recognition) software, but not all of it. In version 1.4.1 (or later), a few witticisms remain. To hear them for yourself, you need the following: (a) a Mac with a four-digit model number, and (b) the software known as PlainTalk 1.4.1 (or later). (If you can’t find that software on the CD-ROM that came with your Mac, or sitting in your Apple Extras folder, you can download it from America Online or the Internet site http://www.apple.com.)

Anyway, once you’ve installed said software, you’ll have a control panel called Speech Setup.

1. **Open the Speech Setup control panel.**
The control panel opens, displaying a pop-up menu at the top.

2. **From the pop-up menu, choose Feedback.**
Using the next pop-up menu, you can choose from among the different voices installed on your Mac: Fred, Victoria, and so on.

3. **Choose a voice from the pop-up menu, then click the first little speaker icon.**
You’ll find that the Apple programmers chose funny, appropriate things for their little imaginary friends to say. For example,
the voice called Vincent says, "I sure like being inside this fancy computer!"

The shaky voice called Deranged says, "I need to go on a really long vacation." The alien monotone voice, Zarvox, says, "That looks like a peaceful planet." And Whisper whispers, "Psssst—hey you, yeah you! Who do ya think I'm talking to, the mouse?"

Collect them all!

Speaking of the PlainTalk software, if you're the lucky owner of a Power Mac or four-digit Performa model, you can actually use the *speech recognition* aspect of your Mac. You need a microphone, of course, and you need to read the instructions in the Speech control panel. But once you get speech recognition working, try saying to your Mac, "Tell me a joke!"

Amazingly enough, your chosen character (Fred, Deranged, or whoever) will then attempt to tell you a knock-knock joke. Play along... you'll be amazed how good your Mac would be at a cocktail party.
Who's the Macintosh Guide, Anyway?

Macintosh Guide, of course, is the feature (in System 7.5 through 7.6) that's supposed to teach you basic Mac skills. Choose Macintosh Guide from your ? menu, choose a topic (such as *How do I change the speaker volume?*), and follow the onscreen instructions.

One thing Macintosh Guide won't help you with is viewing the secret Easter egg. To do that, you need these steps:

1. Choose *Macintosh Guide* from the ? menu at the top of your screen.

   After a moment, you get a starting screen. You'll see a little paragraph of explanation and three big square buttons at the top.

2. While pressing the Control, Command, and Caps Lock keys, click anywhere in the white part of the window. Hold the mouse button down.

   You've just uncovered the secret screen filled with the names of the Guide programmers. Man ... who knew it took so many to write a feature used by so few?
At Ease, Ladies and Gents

At Ease™
Mark Neubieser
Michael Stein
John J. Wang
Paul Wenker
Scott Marcy
Version 2.0.3

This is when you start wishing you'd bought a Performa. Only Performa models, you see, came with At Ease, the super-simplified interface without a Trash can, folders, or disk icons—only neatly arrayed jumbo icons that launch your favorite programs and documents. (Only one click is required.)

If you do have At Ease 2.03 or later, and you've turned it on (using the little At Ease Setup program), you can enjoy not one but two delightful Easter eggs. To make these work, you must be at the actual At Ease screen that appears when your Mac turns on—jumbo icons and so on—not in the At Ease Setup program.

1. While pressing Option, choose At Ease from the Apple menu.

The regular At Ease screen is cute enough, what with all those little animated Weebles' heads turning around. But the Option key buys you, after a moment, additional scrolling credits at the bottom of the screen.

Those secret credits, however, are only an egglet compared to Part II:
2. Click to get rid of the About At Ease screen. Now choose At Ease from the Apple menu—this time, *without* holding down any keys.

The regular At Ease About box appears, without scrolling credits.

3. Carefully point the tip of your cursor at the head of the upper middle Weeble head.

Watch in amazement as the little cartoon head changes into the *real*, photographic head of the main programmer.

Double your fun by pointing to the lower middle Weeble, too, and marvel as Scott Marcy’s head pops into sight.
Balloon help must have looked good on paper. It’s the Mac’s electronic help desk; you point to some mysterious onscreen software element with your cursor, and a little cartoon balloon pops out of the mystery object explaining its purpose. For example, you can point at the upper left corner of a window, and the balloon says, *To close this window, click here.*
Balloon help wasn’t the hit it was supposed to be. That’s probably because (1) it’s too much hassle to choose Show Balloons from the ? menu (or the Help menu) on the screen (and Hide Balloons when you’re done); (2) the help messages were written by the very same programmers who created the confusing onscreen objects to begin with!

It didn’t take long to dawn on America’s programmers, therefore, that these generally ignored help balloons are the perfect place to stash secret messages, credits, and other Easter eggs. The instructions for revealing these sweet nothings are always the same:

1. From the ? menu (or the Help menu), choose Show Balloons. Point at something on the screen.

Assistant Toolbox

The Assistant Toolbox is an extension for PowerBooks only. Open your System folder; open your Extensions folder; and point to the Assistant Toolbox icon. What are those weird arrows supposed to be?
Cache Switch

You only have this control panel if you have a Quadra, Centris, or 1994-era PowerBook. If you do have the panel, point to the version number. Wink, wink!

CloseView

You probably don't have CloseView in your Control Panels folder; you generally have to look in your Apple Extras folder for it. Pity, really; the balloon that appears when you point at the control panel icon is pretty cute.

Use Balloon Help on the CloseView icon. The surprise here isn't what text appears inside the balloon; it's how it appears—at 400 percent of its actual size!

Date & Time

Date & Time, of course, is the control panel where you can change your Mac's clock. Choose Control Panels from your Apple menu; open Date & Time; and point, with Balloons on, at the Daylight
Savings Time checkbox. You get a cute reminder that helps you keep your seasons straight.

**Eudora Light**

These aren't Easter eggs, per se; they're just really funny balloons, per se. Click on the little square at the far left of a new outgoing Eudora Light message and hold the button down.

Read the descriptions of the Priorities in the pop-up menu!

**MacsBug**

The trouble with life is: Some of the best Easter eggs are in software nobody actually has. In the case of MacsBug, a programmer’s tool, getting it isn’t so difficult: You can download MacsBug from America Online or the Internet.
If you do so, and you point to it with balloons on, you’ll find this witty message: *This file provides programmers with information proving that it really was a hardware problem.*

**QuickDraw 3D**

This extension comes on the CD-ROM with most modern Power Macs; it lets you manipulate 3-D objects easily on the screen. If you have it sitting in your Extensions folder (which is inside the System folder), or still waiting inside your Apple Extras folder, you’re in luck. Point to it to see the enticing balloon message *Flatland no more. Come and follow us into the Third Dimension!*

**QuickTime**

If you open your hard drive, and then open your System folder, and then open your Extensions folder, you’ll almost certainly find the QuickTime icon. Turn on balloons, and enjoy the definition.
If you enjoyed the Speech Setup Easter egg, then you can enjoy the Speech Macro Editor egg. Speech Macro Editor is where power users create their own things—the Mac can understand when you talk to it.

But frankly, it's just as much fun to choose About Speech Macro Editor from the Apple menu, turn on Balloon Help, and point at the pictures on the left side of the window.

If you have a desktop Mac with a four-digit model number, your computer can respond to spoken commands (and I mean more than “Play dead!”). You may have to install the PlainTalk 1.4.1 (or later) software, if you don’t have it already; it came on your Mac’s CD-ROM (if yours has a CD-ROM drive), or you can download it from America Online.
Anyway, open the Speech Setup control panel (open Control Panels from your Apple menu). Point to the version number. Ladies and gents, may I present: the first balloon with *graphics* in it!
In terms of name recognition, ResEdit doesn’t exactly rank right up there with Photoshop and ClarisWorks. This program doesn’t come with any Mac models; you can’t buy it in stores. And yet, among power users, ResEdit is one of the most influential, talked-about pieces of software ever written.

In brief, ResEdit is a program that lets you treat all your other software like Lego blocks, snapping apart pieces, replacing them, copying and pasting them. ResEdit lets you edit (change) the
resources of other software: It lets you change what the menus say, what the icons look like, what size the buttons are, and so on. You might think of ResEdit as a first taste of programming for people who have no intention of learning anything difficult.

Anyway, because the layman generally doesn't use ResEdit, programmers find it a convenient place to put Easter eggs—after all, only other programmers, the most difficult crowd to impress with Easter eggs, are likely to see them there. You, however, can get ResEdit very easily; it's available for downloading from America Online or Apple's Internet sites (such as www.apple.com).

Most books, when discussing ResEdit, take a tone best summarized by the phrase “Be afraid. Be very afraid.” Such books point out that if you use ResEdit to dissect the guts of your other software without much caution or control, you run the risk of lobotomizing those other programs and rendering them useless.

In this chapter, however, you won't actually be changing anything; you'll just be looking at things.

The Apple Kitchen-Appliance Suite

Since teenager Steve Jobs promised to make the Macintosh as common as a household appliance, kitchen machinery has apparently obsessed Apple's programmers. Arm yourself with a copy of
ResEdit, set aside a rainy afternoon, and embark on this Quest for Kitchen References.

1. **Launch the ResEdit program. Click to dismiss the jack-in-the-box; click the Desktop button; open your hard drive; open your System folder; and open the file called System.**

   The Mac will react with a horrified message, along the lines of “You can’t be serious! You wanna go mucking around in your System file? That most precious of files?” Simply click OK; you’re just looking, thank you.

   Now you’re presented with a huge window full of icons. Each represents some piece of the programmer’s work: a menu here; the text of a dialog box message there.

2. **Locate the icon called STR; double-click it to open it.**

   If you’re having trouble finding the STR resource, just type the first couple of letters.

   Now you’re seeing a tall, skinny list filled with numbers in two columns.

3. **In the left-hand column, find the number -16579. Double-click that row.**

   You’ve just opened a resource—in this case, some kind of secret internal message. Notice the comment at the end: *It slices, it dices!*—Kitchen Appliance Reference #1.
4. Having savored the first appliance reference, close the "slices, dices" window. You should be back at the tall skinny window full of numbers.

5. In the left-hand column, find the number -16569. Double-click that row.
This time, you’re told that Jim Reekes calls this the spatula. Riiight.

6. Close the spatula window. For Kitchen Reference #3, open the row called -16580.
This time, good ol’ Jim Reekes calls it the fridge. Aha.

7. Close the fridge window; close the tall skinny numbers window. Now you’re back at the big window full of icons.

8. Locate the icon called ICON (its icon looks like an exclamation point in a triangle). Double-click it.

Kitchen References #4, 5, 6, and 7: little icons representing a TV, a blender, a fridge, and a flour mill. Just what exactly do Apple programmers do all day long?
9. From the File menu, choose Quit. If you're asked to save changes, click No.

Maybe it's best that I don't mention the Toilet Plunger icon that appears in the ICON resource of the QuickTime extension file in your Extensions folder . . .

Apple Guide's Secret Credits

Apple Guide, the feature of System 7.5 or later that acts as an onscreen coach for basic tasks, offers a secret credits screen (see Chapter 3). But the more entertaining secret About box can only be viewed with ResEdit.

1. Launch ResEdit. Click to dismiss the jack-in-the-box; click the Desktop button; open your hard drive; open your System folder; open the Extensions folder; and double-click the file called Apple Guide.

The usual ResEdit landscape appears: a big window full of cryptically named icons.

2. Find the icon called TEXT. Double-click it.

Up pops a list of four numbered items.

3. Double-click the line called Who?

Here at last is the real programming team, complete with
nicknames. You can only imagine how interesting it would be to have dinner with, say, Greg “twin-turbocharged” Brewer, Amy “pound on it” Hansen, and John “follow me, I’m lost” Powers.

After the hilarity begins to subside, close the list of programmers. Now try opening the row (in the previous window) called EndOfTheLine. As the man says: Stop and take a break, you deserve it.

4. Close all the windows. If you’re asked to save changes, click No.

Apple Internet Connection Kit

The Apple Internet Connection Kit, as if you couldn’t figure it out, is a program that makes it easy to connect to the Internet for the first time. But Easter egg hunters say: Internet, schminternet. Let’s get to the Easter eggs!

1. Launch ResEdit. Click to dismiss the jack-in-the-box; click the Desktop button; open your hard drive. Now open the Apple Internet Connection Kit folder. Find the little program called Apple Internet Status and double-click to open it.

Up pops our friend, the ResEdit Big Window Full of Icons with Funny Names.
2. Double-click the icon called STR#.
Up pops the now-familiar two-column skinny window full of numbers.

3. Find the row numbered 1020 and double-click it.
Welcome to another window, this time listing individually numbered str#’s (strings, meaning blobs of text).

4. Double-click the one numbered 27.
The message, clearly of interest primarily to programmers, is AEObject-Edition Sample would like to complain about an error it encountered, please bring it forward so it can whine at you.

5. For more fun, choose Open from the File menu. This time, open the little program called Internet Configure. Again, open the icon called STR#. This time, double-click the row called 26724.
In the resulting window, you’ll find a list of text blurbs clearly designed to be Balloon Help messages. Some programmers were clearly having a party writing these help messages:

20 Type your News authentication username here. Just leave this blank unless you have problems with News authentication (in which case you should kill your system administrator).

93 Open a new preference document. Not available because we don’t like you.
99 Close the front window. Not available because there is no front window. Obvious really.

117 Select All. If you don’t know what this means, I suggest you go back to Macintosh Kindergarten.

123 Beats me why this would be disabled.

6. Close this window, so that you can see the list of STR#’s.

This time, double-click row 128.

Scroll down far enough, and you’ll find these gems:

14 Our enemies shall talk themselves to death, and we will bury them with their own confusion. We shall prevail.

16 Warning, font crime is being perpetrated. Call 1-800-FONT CRIME to report this offense!

---

Find File’s Secret Message

Ever wonder if programmers get sick of hacking silicon all day long? If you have System 7.5 or later, you can find out the answer.

1. Launch ResEdit; click to kill the jack-in-the-box. Click the Desktop button. Open your hard drive; open your System folder; open your Apple Menu Items folder; double-click Find File.

Your screen fills with icons.
2. Double-click the icon called DATA; in the next window, double-click the row called ID #0.

There, mixed in among the computer codes in the right-hand column, about an inch or two down from the top, you’ll find the tiny lettering of the programmer’s secret complaint, a fond reminiscence to the days before silicon chips:

“I liked vacuum tubes better!”
The Compiler's Secret World

What fun programmers must have! They alone have the power to create new Easter eggs; what's more, they alone get to see some of the best ones!

MPW (the Macintosh Programmers' Workshop) software is a case in point. While the average Mac fan will never have access to this program, programmers use it every day. Lucky them: They may get to see some of these hilarious error messages in their daily routines:

You can't modify a constant, float upstream, win an argument with the IRS, or satisfy this compiler.

Can't cast a void type to type void (because the ANSI spec. says so, that's why).

String literal too long (I let you have 512 characters—that's 3 more than ANSI said I should).

... And the lord said, "Lo, there shall only be case or default labels inside a switch statement."

A typedef name was a complete surprise to me at this point in your program.

"Volatile" and "Register" are not miscible.
Only one parameter per register, please.

Type in (cast) must be scalar; ANSI 3.3.4; page 39, lines 10-11 (I know you don’t care, I’m just trying to annoy you).

This array has no size, and that’s bad.

You can’t go mucking with a ‘void.’

We already did this function.

This label is the target of a goto from outside of the block containing this label AND this block has an automatic variable with an initializer AND your window wasn’t wide enough to read this whole error message.

Call me paranoid, but finding ‘/*’ inside this comment makes me suspicious.

Too many errors on one line (make fewer).

Symbol table full—fatal heap error; please go buy a RAM upgrade from your local Apple dealer.

Trailing comma not permitted in enum definition. (This time I’m letting you off with a warning.)
As you've no doubt noticed, not every Easter egg is a hidden credit. Sometimes they're just irrepressible bursts of programmer humor—like this one, which you can only see if you own a Global Village modem. Check now: In your Control Panels folder, do you have a control panel called Teleport? If so, and it's version 2.5 or later, then fire up ResEdit and proceed.

1. After clicking away the jack-in-the-box, click the Desktop button. Open your hard drive; open your System folder; open your Control Panels folder; open Teleport.

In the array of icons before you, scan for the one called STR#—as we've learned by now, a popular place for programmers to bury their secret messages.

2. Double-click the STR# icon. Scroll down to item 33.
There, nestled among the perfectly normal error messages, is one you’re likely never to see: “Your Teleport is on fire. Please call the local fire department.”

Gerbils!

You’d have to have a pretty recent Mac to find Gerbils! in your Apple Extras folder. It’s a game designed to show off the amazing abilities of QuickDraw 3-D, the software a Power Mac can use to play with 3-D “models” on the screen as easily as everyone else plays with still graphics.

If you do have Gerbils! (or if you download it from Apple’s Internet site), you can see who wrote it—not just their names, but their photos.

1. Launch ResEdit. Click to dismiss the jack-in-the-box. Navigate your way until you see the Gerbils! icon; open it.
   Voilà: the ResEdit icon gallery.

2. Double-click the icon called PICT. Scroll down to the one numbered 145, and open it.
   There he is—programmer #1. (Programmer #2 is hiding in the one numbered 146.)
Assistant Toolbox

The Assistant Toolbox is an extension found only on PowerBooks. It has, no doubt, some very important function; for the Easter egg, however, its primary value is in its deep-seated secret credit.

1. Launch ResEdit. Click to dismiss the jack-in-the-box. Click the Desktop button; then open your hard drive; then open your System folder; then open your Extensions folder. Inside, find Assistant Toolbox and open it.
   Once again, the ResEdit icons.

2. Double-click the icon called KINI.
   First of all, check out (but don’t open) the rows numbered 2, and 51, and 111. For some reason, they’re named Sleep, Cram, and Keep Talking.

3. Double-click row 51—the one called Cram.
   Deep in the programmery gobbledygook, you’ll find the secret credits: NuCafe Development: Kevin, Testing Queen: Maxine, Bad Dog: Kaz, Mr. Later: Keith, Script Mastery: Cheryl, Instabuild: Mark, Mr. Patoey: Tim, Mr. Product: Ron, Write Stuff: Kristy, Perry Malos: Jeff, Real SCSI: James.
ResEdit’s Very Own Easter Egg

You’ve spent all this time using ResEdit to explore the innards of other software. Now it’s time to turn it inward on itself.

1. Launch ResEdit. If that infernal jack-in-the-box appears, click to get rid of it, and click Cancel.

   All those steps were designed to tell ResEdit not to try opening some other piece of software.

2. Turn down the radio. While holding the Command, Option, and Shift keys, choose About ResEdit from the Apple menu.

   If there was ever a ruder, more gurgly pig-oinking sound, it would be hard to imagine.

   Pig Mode, since you asked, is a special mode used during programming in which ResEdit compresses whatever it’s operating on. Repeat Step 2, by the way, to see the message, Stop Pig Mode (no oink), which, of course, exits this porcine process.
ResEdit's Secret Credit

Pig Mode isn’t the only hidden feature in ResEdit; there’s a secret About box to be discovered, too.

1. Launch ResEdit. Click to nuke the jack-in-the-box, and click Cancel.
   Now you’re ready:

2. While pressing Command and Option, choose About ResEdit from the Apple menu.
   It’s not much, but at least it’s secret!
You're this far through the book, and so far almost all of the Easter eggs have been buried right in the Macintosh operating system itself! We haven't even begun to delve into the offerings from Claris, Microsoft, Adobe, and other companies.

Of course, you can only relish the following buried treasures if you actually have access to the programs in question. But they're well worth hunting down. Inquire at your local user-group meeting; visit other cubicles at the office; offer cash for the
chance to play with these programs; do what you have to do to witness these amazing undiscovered beauties.

**HyperCard: Star in Your Own Easter Egg!**

This trick *doesn’t* work with HyperCard Player, the useless little software gadget that comes with every Macintosh. It only works with HyperCard, the program you *buy*, and only in versions 2.0 and later.

That said, however, this Easter egg is worth pursuing for a singular reason: It lets you be the star of the secret About box!

1. **In HyperCard, while pressing the Option key, choose About HyperCard from the Apple menu.**

   Bingo: the secret About box! Yes, it's all full of interesting facts about your Mac. But the most interesting of all is the headline at the top of the box: *HyperCard by Michael Jackson* (or whatever your name happens to be).

   Now, it so happens that HyperCard gets your name from the Sharing Setup control panel. If you haven't yet typed your name into that control panel (which you'll find in your Control Panels folder), then HyperCard will just display one of its *actual* programmers' names in this secret About box instead of yours.
Somebody explain this one to me. Is it a programmer showing off? Is it a programmer’s morbid fear of death? Is it a programmer obsessed with Slinkies?

1. Launch FreeHand version 4 or 5. While pressing Shift, Option, and Command, choose About FreeHand from the Apple menu.

The normal About box appears. So far, nothing unusual, Captain.

2. Click somewhere in the picture.

Oh my God! It’s a worm! Everybody back—it’s out of control, bouncing around the dialog box, hungrily lashing its little worm tail across your screen.

3. Click again. And again. And again!

Worms, worms, everywhere! Somebody stop the madness! (Maximum Worm Limit: 16 Worms.)
Netscape's 29 Easter Eggs

Netscape Navigator, of course, is the software most people use to visit the Internet's most popular attraction, the World Wide Web. What's especially handy is that, since the whole point of the Web is *Click to make a surprising new screen appear*, you might consider it one vast global Easter egg.

At least the programmers at Netscape thought so. That's why, if you type certain URLs (Web page address codes) into the little Go To strip at the top of the screen, you'll be taken immediately to secret About boxes that are, in fact, secret Web pages!

Naturally, these Easter eggs are reserved for those who (a) have an Internet account and (b) use Netscape Navigator.

1. **Sign onto the Web, however you usually do it. Launch Navigator.**

   After a while, the usual gray-background Netscape window appears. At the top, you'll notice the usual thin horizontal text box, labeled Go To, where a Web page's address may be typed.

2. **Drag through whatever's in the Go To URL box and press the Delete key to get rid of it. Type one of the following codes and press Return.**
By "following codes," I mean any of the following Web page addresses in the left-hand column below. (Note that these codes don't begin with http://www, like most Web addresses.) Each, when you press Return, takes you to a special Web page showing the details about one of the Netscape programmers.

<table>
<thead>
<tr>
<th>Type this . . .</th>
<th>. . . to see this page</th>
</tr>
</thead>
<tbody>
<tr>
<td>about:</td>
<td>the generic Navigator About screen</td>
</tr>
<tr>
<td>about:authors</td>
<td>an outdated &quot;about the authors&quot; screen</td>
</tr>
<tr>
<td>about:javalogo</td>
<td>the logo for Hot Java, the programming language</td>
</tr>
<tr>
<td>about:rsalogo</td>
<td>the logo for RSA Data Security</td>
</tr>
<tr>
<td>about:logo</td>
<td>shows the Netscape logo</td>
</tr>
<tr>
<td>about:ari</td>
<td>Ari Luotonen's page</td>
</tr>
<tr>
<td>about:atotic</td>
<td>Aleks Totic's page</td>
</tr>
<tr>
<td>about:blythe</td>
<td>Garrett Blythe's page</td>
</tr>
<tr>
<td>about:chouck</td>
<td>Chris Houk's page</td>
</tr>
</tbody>
</table>
The Great Macintosh Easter Egg Hunt
about:terry  Terry Weissman’s page
about:timm   Tim McClarren’s page
about:Mozilla  A quote from the Book of Mozilla, the Netscape mascot!

Take special relish in viewing Marc Andreessen’s picture, by the way; he’s the guy who, when Netscape’s stock became available on the open market, became a billionaire overnight. At the age of twenty.

Netscape’s Emergency Keystrokes

As far as most of the world knows, the only way to move around in the World Wide Web using Netscape is (a) type a Web page’s address into the Go To box at the top of the screen, or (b) click buttons and underlined phrases on the Web pages themselves.

But when you’re bored, or panicked, or in a hurry, try one of these emergency keystrokes that teleport you to special, pre-selected Web pages.

1. While pressing the Control and Option keys, type a W.
I'll bet Ross Perot never knew it was so easy to get to the White House.

2. While pressing Control and Option, type the letter F.

Now this is an important page: the Fish Cam. Every few seconds, this picture of somebody's aquarium is updated, so that you always know the exact position of each fish therein.

The Easter Egg Hall of Classic Greats

MacsBug is a piece of free Apple software, downloadable from America Online or the Internet. It's just about the most technically intimidating program ever written.

What it stands for is Motorola Advanced Computer Systems Debugger. What it does is let programmers debug their work and muck around in the deepest, most central organs of the Macintosh circuitry. When it comes to Easter eggs, MacsBug-viewable Easter eggs are the most devious and difficult to access of any on earth.

If you're technically inclined, especially courageous, or just fool-hardy, you can try to find these yourself. Download MacsBug, install it by dropping its icon on your System folder, and restart the computer—then read on. If you're anyone else, perhaps you'll enjoy merely reading about these most buried of treasures.
Here's how to make MacsBug's hideous, code-filled screen appear: While pressing the Command key on your keyboard, press the power key. By typing special codes, you can jump to a particular place in the computer code, to see what's been left behind by the programmer for other programmers to find. The messages differ according to your Mac model.

To get out of the screen full of computery gobbledygook, by the way, just type the letter G, press Return, and you'll be deposited back in whatever you were doing.

*The MacsBug Author Screen:* Once you've made the MacsBug screen appear, type DV and press Return. You'll see the secret credits of the guys who wrote MacsBug itself. Only one question: When these guys were writing the MacsBug debugger, what did they use for debugging it?

*Mac SE/30:* If you have this particular model, make the MacsBug screen appear, type G EB1000 into MacsBug (those are zeroes), and press Return. You'll see the secret Macintosh SE/30 Engineering Hall of Fame screen.

*Mac IIci or Mac IIsi:* In the MacsBug screen, type DMA 4086EC48 999 (if it's a IIci) or DMA 4086F088 20 (if it's a IIsi) and press Return (those are all zeroes). You'll get to see the hidden message: *SO . . . WHAT ARE YOU STARING AT?*
Quadra 840AV: Into the debugger screen, type DMA 40811FE8 240 and press Return. You'll get a huge swath of credits for "The Super Rom™ Super Team," including thankzzz to all who contributed to past ROMs and system 7.x.

While you've got the debugger running, try DMA F9A4D4 100 (to see the thrilling message Barf, no more empty queue elements-LeakWatching). Or type DMA E5E83E 100 for more typically inside-jokey Apple credits: Peace, Cow Boys, Frogs, Sayonara, Krisprolls, Vikings, Reindeer, Bowler Hats, Spaghetti, Bankers, Chocolate, Aussies, and so on.

Performa 6115CD: Type DMA 3A091 50 or DMA 3E4F1 50 into the MacsBug screen. You'll arrive at the none-too-cheerful message Ol' McDonald had a Farm . . . It's also a bitch, then you die too!

If that's a little too depressing, type DMA D13E1 999, DMA EA811 999, DMA EB111 999, or DMA 40A98202 999 (the text changes locations so it should be around those addresses listed) to see an enormous list of inside Apple jokes. They range from such thigh-slappers as THE NASTIEST, GNARLIEST, TEXT TOOL AROUND and HER FLOWING HAIR INSPIRED US ALL to WOULDN'T HAVE DONE IT WITHOUT THE POWDERED TOAST MAN and THE MOST COMPLEX THING EVER INVENTED.
**PowerMac 7500:** Once the MacsBug screen is up, type *DMA 00034FC0* (and press Return) for the unexpected message: *Hey, put this in ROM for real!*

---

**Merlin the Photoshop Magician**

If you think Photoshop 3.0 through 4.0 is pure magic, you’re right. Now you can prove it.

1. **From the Windows menu, move your mouse down to Palettes; from the submenu that pops out, choose either Show Layers, Show Channels, or Show Paths.**

   The Layers, Channels, and Paths palette appears on your screen, if it wasn’t there already. Note the right-pointing triangle in the upper right corner of the little window. It’s a pop-up menu.

2. **While pressing the Option key, click the little pop-up menu/triangle and hold the mouse button down.**

   A pop-up menu appears.

3. **From the pop-up menu, choose Palette Options.**
Your reward is one of the most charming dialog boxes in all of Macdom. Not only is Merlin himself adorable, but the button to dismiss the dialog box is one all dialog boxes should have: Begone!

The Easter Egg Hall of Classic Greats

The logo for Finale, the best-selling sheet music program for the Mac, was, for years, a stylish Art Deco silhouette of a conductor in tuxedo, baton raised high over his head in mid-fiery-downbeat. You could almost hear the Art Deco orchestra he must have been conducting.

Apparently he grew tired of holding his arm over his head for all those years in Finale’s About box, however. In version 2 of the program, if you waited for thirty seconds, Mr. Conductor logo not only dropped his upheld arm—he finally disgustedly stepped down off his Art Deco silhouetted podium and walked away, leaving the About box empty!

Alas, programmer Phil Farrand’s masterpiece Easter egg was removed from version 3 of the program—along with the 45K of animation code it added to the program!
Photoshop Transient Witticisms™

This Easter egg, while not exactly dripping with interactivity or multimedia, squeaks into this book by virtue of its funniness alone. To make it work, you need some version of Photoshop 3.0.

1. **Choose About Photoshop from the Apple menu.**

2. **Wait.**
   After a moment, credits will begin to scroll up the screen. They get funnier as the list goes on; at the very end of the list, your name appears, and you get thanked for being “one of our favorite customers.”

3. **Watch the space just below the Photoshop graphic.**
   In this space you’ll see a virtual stand-up routine typed out, joke after joke—a total of 130 hilarious Generation X pop culture one-liners. There are references to David Letterman (“Hey, everybody! I’m not wearing pants!”), The Simpsons (“‘A tense work environment is a productive work environment.’ —M. Burns”), Star Trek (“Ensign—pursue that vessel at Ludicrous Speed!”), Star Wars (“These aren’t the droids we’re looking for”), Ren & Stimpy (“You EE-diots!”), Monty Python (“Brought to you by the Ministry of Silly Walks.”), Spinal Tap (“It has dials that go to eleven.”), and the life of the programmer (“‘This filter is better than sex! Not that I
could actually tell . . . ’—unknown engineer”). You’ll be chuckling away for five minutes or more. Eventually, you’ll even see what the programmers call this little display: Adobe Transient Witticisms™.

Photoshop’s Multiple-About-Box Personality

You already know, having read Photoshop’s Transient Witticisms™, about stand-up comedy monologue. You may not know, however, about Photoshop’s dueling About boxes.

1. Choose About Photoshop from the Apple menu.
   Nothing unusual here, Officer. It’s About Box Number One.

2. Click to dismiss the box. This time, choose About Photoshop while holding down the Option key.
   But—gasp!—it’s a completely different About box! Knoll Software? Who’s that?

3. Click to dismiss that box. Finally, choose About Photoshop while holding down the Command key.
It's About Box Number Three. Adobe . . . Knoll Software . . . Tiger Mountain Software . . . Who wrote this thing, anyway?

The Word 6 Forbidden Credit

As noted in the Introduction, it's official Microsoft policy never to credit its programmers. Since this decree came down from the Richest Man Alive Himself, Bill Gates, you can appreciate that putting Easter eggs into Microsoft programs is a somewhat more daring act than it would be at other software companies.

As a result, this Easter egg in Word 6 has one of the most convoluted and nonsensical “triggers” in history. And now the word is out.

1. Create a new Word 6 document. On the new blank screen, type *T3!* (including the exclamation point).
   And what does *T3!* mean? The world may never know.

2. Highlight your *T3! and make it bold.*
   For example, click the big fat letter *B* on the light gray toolbar.

3. From the Format menu, choose AutoFormat. Click OK, then click Accept.
   *Told* you this would be convoluted.
4. From the Apple menu, choose About Microsoft Word. The very non-secret, non-interesting About box appears.

5. Click the Microsoft Word icon in the About box. The screen goes black . . . thunder rumbles somewhere . . . and, before your very eyes, a scrolling list crawls up the screen in pretty colored lettering. In the list are the names Bill Gates swore would never appear in one of his products—*programmers!*

**Word 6’s Other Forbidden Credit**

Just to get Bill Gates *really* mad, the Word 6 programmers didn’t stop with a mere scrolling list of credits. They also pulled off this little stunt:

1. **Create a new Word 6 document. Type the word *zzzz.***
   You have to put four Zs. Three won’t work, and five is right out.

2. **Spell-check your document.**
   Word flags the word “zzzz” as incorrectly spelled, all right. But check out what it suggests as the correctly spelled equivalent: *sex!* “Sex” = “zzzz”? Only from the minds of Microsoft.
The Secret Quark Programmer Photos

Considering Quark, Inc.'s reputation for surliness and hostility toward its customers, it's a wonder the employees would want to show their faces. Still, a few programmers took that bold step.

1. Launch QuarkXPress 3-point-something. Choose About QuarkXPress from the Apple menu.
   The Environment dialog box appears.

2. While pressing Command, Option, and Shift keys, hold the mouse down anywhere in the dialog box.
   There they are: four manly portraits of four manly programmers. The Louvre it ain't, but it's better than nothing.

PowerPoint 4.0

This Easter egg won't blow your socks off. But anything from Microsoft, as we know, represents a bold strike of defiance against Big Brother Bill Gates, so it's worth documenting.

1. From the Apple menu, choose About PowerPoint.
   The usual Microsoft info screen appears.
2. Click the PowerPoint logo in the upper left corner of the box. Aha—so that’s who’s responsible!

WriteNow 4.0

WriteNow isn’t the world’s most popular word processor; in fact, it’s not even sold anymore. But for years, it was beloved by a select few hundred thousand because of its clean design, fast response, and delightful Easter egg.

1. Choose About WriteNow from the Apple menu. 
The boring About box appears.

2. While pressing Option, click anywhere in the About box. 
Suddenly, an army of miniature animated workmen run onto the screen, grab the letters of the programmers’ names, and rearrange them to spell out the names of other people who helped with the program. And don’t miss the bulldozer, whose job it is to crush the copyright notice.

Retrospect 3.0

Dantz Development’s Retrospect is the best-selling backup pro-
gram for the Mac. In version 3.0, code-named "Peary," a history lesson lurks—if you know how to find it.

1. **From the Apple menu, choose About Retrospect.**

   In the resulting window, there are three folderlike “tabs” to choose from. If you click the Credits tab, you get a three-minute display of scrolling programmers’ names, not particularly breathtaking.

2. **Option-click the Credits tab.**

   Instead of credits, you see the handsome mug of Sir Robert Edwin Peary, Arctic explorer. And if you wait long enough, his head will scroll off the screen, to be replaced by a complete scrolling history book chapter about his life and accomplishments! So *that’s* where the code name came from . . .
It's a damned shame, really, that Apple's eWorld on-line service went out of business in early 1996. Not because it was a terrific service—it wasn't, at least not compared to America Online's vast offerings. No, eWorld was adorable primarily because of its Easter egg.

The famous Town Square was the first thing you saw when you signed onto the service. It looked like a sunny, happy land, filled with little Weeble people walking among sunny, happy buildings.

But if you clicked the mouse in the extreme upper left corner of this welcome screen, day turned to night—and a starry sky replaced the bright sunshine of the normal screen!

As mentioned in the previous chapter, Apple's Internet Connection Kit is a painless, easy way to sign up for Internet service. It's also a painless, easy way to savor some of Apple's best Easter eggs.

The software program called Apple Internet Dialer is the one
that puts the little thin strip of dialing info at the lower left corner of your screen—the one with the Dial button. Its most prominent graphic is a little picture of a globe with a Mac next to it. Turns out this little graphic is a veritable Easter egg basket.

1. **Click the Macintosh icon in the main window.**
   Its right eye blinks!

2. **Option-click the Mac icon for Easter egg #2.**
   Across the tiny Mac’s monitor, a message runs by, bearing a cryptic credit: *The other Ron managed the whole thing and Steve was seen somewhere in the vicinity...*

3. **While pressing Control, click the Mac icon to see Easter egg #3.**
   This time, the message on the Mac’s monitor says: *Ron, Abe, Cyrus, and Mike found the bugs so you don’t have to! What a group of guys!!*
   For the record: Thanks, Ron, Abe, Cyrus, and Mike.

4. **While pressing Command, click the Mac icon for Easter egg #4.**
   Yet another message on the Mac’s miniature monitor: *Welcome To The Internet. From: Rick (rreynold@rockstar.com) & Gary (garyaiki@crl.com).*
   This is your chance to send E-mail to some actual Easter egg authors!
5. **Click the little Mac while pressing both Command and Control. It's Easter egg #5!**

This time, you find out that the Apple PR machine has suckered you in: *The marketing folks, Lance, Richard, Beth and Lynn. You bought this, so they done good!*
The Easter Egg Hall of Classic Greats

Considering the difficulty of embedding Easter eggs in Microsoft products, the fact that Excel version 3 had such an impressive show is all the more amazing. As usual in Microsoft programs, though, the trigger was hopelessly complex.

You were supposed to choose Style from the Format and type excel. Then you had to choose About Excel from the Apple menu and click the Excel logo.

Next, you were to press Command-right arrow and Command-down arrow, to highlight the very last cell in the spreadsheet; make the row height and column width both zero; click the down and right scroll-bar arrows until no cells at all were showing; and finally, click the upper left corner of the window.

Your reward for all this? An unbelievable animation involving a huge foot descending on the icon of hapless rival Lotus 1-2-3—and crushing it!
Microsoft Word 4

Microsoft never was known for its originality . . .

1. **Choose About Microsoft Word from the Apple menu.**
The extremely uninteresting About box appears.

2. **Command-click the Word icon.**
Holy smokes! You get the names, not of the programmers, but of the testers!

Microsoft Word 5

Actually, this Easter egg lurks in all versions of Word 5, including 5.1, 5.1a, and so on.
1. While pressing Command and Shift, choose Preferences from the Tools menu.

What appears to be the usual Preferences dialog box appears, complete with scrollable icons down the left side of the window.

2. Scroll down to the bottom of the icon list; nestled near the bottom, you'll see a new icon called Credits. Click it for a few screens of scrolling credits.

Sometimes you have to repeat these two steps before the balky Credits icon will show up.

Anyway, it's worth noting that (a) these credits scroll weirdly—up to the top, then away to the sides; (b) these credits are multicolored, as in most Microsoft Mac programs; and (c) these credits don't mention the programmers' last names.

Can you say, "Bill Gates doesn't like Easter eggs"?

The Easter Egg Hall of Classic Greats

One of the very first Mac software Easter eggs was also one of the raciest.

It was nestled in one of the original graphics programs, MacPaint 2.0, and when it was revealed, the program's staid corporate owner—Claris—was horrified.
You see, if you pressed the Tab key and Space bar at the moment you chose About MacPaint from the Apple menu, the screen would fill with a surprising full-window painting—of a nude woman, striped like a zebra. (The painting, for those scoring at home, was a scan of an image by erotic artist Olivia de Berardinis.)

Not wishing to be accused of purveying erotic software, Claris caught the programmers red-handed and demanded that the provocative image be removed. As a result, only early copies of MacPaint 2.0 contain the Easter egg; subsequent versions offer nothing so titillating.

**RAM Doubler’s Programmers’ Credo**

It’s not much of a secret that the Two Basic Food Groups for programmers are Pizza and Caffeine. If you own Connectix Corp.’s RAM Doubler, however, that secret is out for good.

1. **Highlight the icon of a “PowerPC-native” program.**
   
   How do you know if a particular program is “PowerPC native”? Well, its box probably bears a sticker saying *accelerated for PowerPC*. Recent versions of Excel (version 5 or later), Word (6), ClarisWorks (4), FileMaker (3), SimpleText, and Photoshop (3)
are some examples. (Word 5 and older versions of those other programs aren’t PowerPC-native.)

2. While pressing Command and Option, choose Get Info from the File menu.

The usual Get Info box appears. Well, it’s almost the usual one. At the bottom of the box is RAM Doubler’s contribution to popular health guidelines: Note: Sleep is a poor substitute for caffeine!

3. Open some other window and move it in front of the Get Info window. Then move the other window away again.

Amazingly, RAM Doubler’s cute little comment is gone! It’s a fleeting little guy; one minute, it’s there—the next, it’s been replaced by the usual Get Info box note about using virtual memory.

StuffIt’s Patriotic Streak

StuffIt Deluxe, the popular file-compression program from Aladdin, came with a terrific feature beginning with version 4.0: It lets you open a compressed folder directly in the Finder, without having to launch the StuffIt program, as you had to in previous versions. The real value of this feature, though, isn’t the time savings—it’s the Easter egg.
1. From your Apple menu, choose Control Panels. Double-click the one called Date & Time.

Date & Time comes with System 7 or later. (Of course, you could just wait until July 4 or December 25 rolls around. This is the easy way.)

2. Change the date to July 4 or December 25.

The year doesn't matter.

3. Close the control panel. Now double-click a Stuffit file on your desktop.

It opens into what looks like a normal folder window, showing all the files inside. Look at the upper left corner of the window, though: There's a little graphic surprise for you! (If it's July 4, you get a tiny flag; if it's December 25, you get—what else?—a Christmas tree.)

4. For added joy, choose Show Balloons from the ? menu. Point to the little flag (or the little Christmas tree).

As though the graphic weren't enough, you now get an appropriate holiday greeting in the little balloon.

The Great Macintosh Easter Egg Hunt
Sometimes it seems too easy to bury an Easter egg someplace where the average Mac user can find it. Sometimes it seems too easy even to bury it where the average Mac user can only find it using ResEdit, as explained in Chapter 5. In fact, sometimes a programmer's only happy if the secret credits are embedded in the *program code itself*

Now, this kind of all-text credit might seem virtually impossible for we mere mortals to pry open, but that's not the case. You *can* read
such messages if you have the proper tools: a high-powered word processor, such as Microsoft Word or WordPerfect, Can Opener, or various shareware programs. The instructions below explain the procedure.

How to Read the Text That Lurks in Any Software Alive

You can read the secret messages in ordinary-looking software in any of three ways. Ways #2 and #3 require, I warn you, somewhat more technical effort.

Way #1: Get your hands on a high-powered word processor program like Microsoft Word or WordPerfect. (ClarisWorks won't work.) In Word, while pressing the Shift key, choose Open from the File menu. You'll be shown the usual Open What File? box, this time showing every single file on your Mac; when you open one, you'll get a lot of gobbledygook—but you'll also see whatever secret messages are there. In WordPerfect, the process is much the same; just be sure, when you choose Open from the File menu, that the File Type pop-up menu says All Documents.

Way #2: Make a copy of whatever it is you're trying to root around
in. (Click on it once, then choose Duplicate from the File menu.) For convenience, drag your duplicate file to the desktop.

From America Online or the Internet, download a program called ???-TEXT. (That's really what it's called!) Use its Open command to open whatever file you're after; following a minute of furious scrolling on the window, you can save the result as a text file (in the Convert menu) that you can open with any word processor (ClarisWorks, whatever).

Way #3: Use a program that can change the invisible type code of a file. Such programs include things you can download from America Online or the Internet: ResEdit (use the Get File/Folder Info command in the File menu); MacSnoop (use the Get Information command in the File menu); File Buddy; or any similar program.

Once you have such a program in hand, duplicate the file you're trying to crack open (again, use the Finder's Duplicate command). Use your utility program to change the four-letter type code of the duplicated file to TEXT. Once you've done so, you can open the file with any word processor.
The OS Fortune Cookie Saga, Part I

It's the oldest gag in the hills. You're at a Chinese restaurant. Fortune cookies are handed out. One of your buddies reads his fortune; everyone smiles. His date reads hers; ah, another good one. But when you peer at yours, you pretend to read, with alarm in your voice: “Help, help! I'm being held prisoner inside a Chinese fortune cookie factory!”

The software gurus at Apple have taken that old joke one step—no, four steps—farther. Embedded in the software of the System suitcase file, in your System folder, is a similar secret message; and, hilariously, this secret plaint has grown and developed with each new version of the operating system. To wit:

1. System 6: Use your text reader to open the System suitcase file.

The System file, incidentally, is inside your System folder. There, among the other programmery codes, is a message: Help! Help! We're being held prisoner in a system software factory!

2. System 7 or System 7.1: Use your text reader to open this System suitcase file.
Over time, the plight of the captives has changed slightly. Now it says, Help! Help! We’re still being held prisoner in a system software factory!

3. System 7.5 and later: Once again, use your text reader to open the System file.

Apparently, the passage of time has muddled the pronoun—it’s “he” this time, instead of “we”: Help! Help! He’s STILL being held prisoner in a system software factory!

Just beneath, you’ll find a complete list of System 7.5 programmers under the heading Also serving time. If you’re using System 7.5.3, you’ll find several clusters of names, each grouped under the appropriate version heading: Serving time for System 7.5.1 crimes, Serving time for System 7.5.2 crimes, and so on.

While you’re at it: If you scroll down in this System 7.5 System file’s text window, you’ll find some secret credits for THE CAST. These credits feature some tantalizing job descriptions—including Underpaid Process Dude, Animal Handlers, Potato Latke Chef, Beermeisters, and Slackers.

There’s also one non-programmer listed—Tristan Farnon. How’d he get in there? As the file tells you, it’s because he paid us ten bucks. Who knew it was so easy to get your name into Apple software?
And finally, elsewhere in the file, a sweet little note embedded in the heart of your System file: Will the last person to leave please turn out the lights?

The OS Fortune Cookie Saga, Part II

When you install Apple's System 7.5 Update 2.0, you turn your copy of System 7.5 (or System 7.5.1, or System 7.5.2) into a fully accredited version of System 7.5.3.

In the process, a new file gets dumped into your System folder. It's called System Update 2.0. Unbeknownst to you, inside it is the happy ending to the "prisoners in a system software factory" saga—a surprise twist that makes all the suffering seem worthwhile.

1. **Make sure your Mac has System 7.5.3 installed.**
   
   To verify this important point, choose About This Macintosh from under your Apple menu.

2. **Use your text reader to open your System folder; open the file within it called System Update 2.0.**

   There it is, right at the top: the final chapter of the "Help! Help!" saga:

   *Mercenaries hit the factory and freed the prisoners.*
Hurrah!

But that's not all the entertainment quotient in this update file. Scroll down a tad, and you'll find additional programmers' names, listed by category: On contract, Freed, armed, and dangerous, Released before the raid, and Fugitives, followed by the gang's inspirational credo: Who dares wins.

Hey, when does the movie come out?

Th-th-th-that's All HyperCard, Folks!

Every Mac comes with an Apple Extras folder. Almost always, inside it, there's a HyperCard Player folder. (HyperCard is a $200 program from Claris that lets you create your own mini-software programs; HyperCard Player is a free program that can run other people's HyperCard creations.)

What few people realize, however, is that every HyperCard document (called a "HyperCard stack") ends with the same sign-off message—in Swedish.

1. Using a text reader, open any HyperCard stack.

For example, your copy of HyperCard Player probably came with a couple stacks called Home, Addresses, and What is HyperCard?
2. Scroll down to the very end.

The very last words of your text document are always *Nu är det slut* . . . , which actually has nothing to do with loose women. That's a common phrase in Swedish that means—"That's all, folks!"

The Great Macintosh Easter Egg Hunt
You don't actually hear much about Easter eggs in equipment. It probably isn't easy to conceal much of anything from your supervisors in a hunk of plastic and metal. Imagine how few trigger possibilities there'd be—you can't exactly hold down the Option key while clicking your printer.

Still, hardware Easter eggs have a proud tradition all their own, from the signatures etched into the plastic case of the very first Macintosh models (see Chapter 1) to the “Where's Elvis?” game of the Newton. May you find them all.
A-Maze-In' StyleWriter II

For six years, the StyleWriter II was America's most popular Macintosh printer. If you've got one sitting around, you probably never suspected its ability to generate printed games for you to play.

1. Unplug the StyleWriter. While pressing its Power button, plug it back in; keep the Power button pressed for 15 more seconds. No lights or sounds will emerge from the printer; for all you know, it's completely dead.

2. Release the Power button, then press it again until the printer starts to print. And print it will—a fun maze for you and the kids to solve!

The StyleWriter II Whodunit

OK, technically, this isn't a hardware Easter egg at all—it lurks in the software that controls the hardware—but this seemed like the right place to bring it up.

1. From the Apple menu, choose Chooser. Make sure that the StyleWriter II icon is selected. Close the Chooser window. If one of those irrelevant dialog boxes appears, just click OK.
2. Launch some program, such as a word processor. From the File menu, choose Page Setup.
   The Page Setup dialog box appears.

3. While pressing Option, click the version number near the top.
   The secret programmers' credit screen appears. Who knew?!

   The StyleWriter Test Page

This one works with any model StyleWriter. Technically, it's only a test page, but since it's truly a hidden credits screen, it qualifies as an Easter egg.

   1. Turn off the printer. Then hold down the Power button until the printer starts printing.

   Depending on your model, the machine may print out a picture of itself, a version number, or an Apple credit.

   Huzza for the Apple CD-ROM

If your Mac has an external CD-ROM drive, get ready for one of the strangest Easter eggs yet. Make sure the CD-ROM software
components (the extensions called Apple CD-ROM, Foreign File Access, and so on) are nestled safely in your Extensions folder.

1. Shut down the Mac. Turn it on again, keeping the keys C and D pressed.

Sooner or later, you'll see one of Apple's wittier secret credits screens; to continue the startup process, click the only Huzza! button you'll ever see in your life.

The Easter Egg Hall of Classic Greats

Alas, the golden age of hardware Easter eggs was the 1980s, when almost every Mac model contained a surprising little secret in its circuitry.

Take the early Macintosh SE models, for example. On their left side, along the vents, was a pair of plastic buttons known as the Reset and Interrupt switches. If you pressed the SE's Interrupt
switch, marked by a broken circle, a blank mysterious dialog box appeared on your screen. If you typed G 41DB9A and pressed Return, you'd see a slide show of photos of the Mac's designers on the screen!

If you're lucky enough to have access to an old Mac IIci, you can try one of the great ones. Set the clock to 9/20/89, which happens to be the date this model was introduced. Set the monitor to 256 Colors in the Monitors control panel. Restart the Mac with four keys pressed: Command, Option, C, and I. Your reward for all this foolishness: a full-color photo of the computer's designers! (If you have IIfx, this trick works equally well—but make the date 3/19/90 and restart while pressing Command-Option-F-X.)

The Chimes of Doom

The Chimes of Doom don't exist to bestow glory on a programmer, like most Easter eggs. But they do demonstrate some of the Apple crew's sickest humor. You hear these dreaded sounds when something is deeply, horribly, electrically wrong with your Macintosh—for example, when one of your RAM chips has gone bad.

The really perverse thing is that the Chimes of Doom themselves
sound quite cheerful. For example, Mac II-class machines play the four separate notes of a happy little A-major chord. LC-class Macs play a flute solo; Quadra AVs play a drum solo; and so on. Only a Power Mac's Chimes of Doom do justice to the sounds' meaning: You hear the digitized recording of a horrifying car crash, complete with tires screaming and glass shattering all over the street.

Fortunately, you don't have to wait until disaster strikes just to hear your Mac's Chimes of Doom. You can hear them any time you want, actually, like this:

1. **Turn off the computer.**

   Now locate its Interrupt button—one of two buttons side by side, usually on the lower side or front of the case. If you don't find any such pea-sized buttons, then your Mac uses a keystroke as the Interrupt button: Command-Power button (that is, the key on your keyboard with a triangle on it).

2. **Turn the Mac back on. ** *Immediately* afterward, press the **Interrupt button or keystroke.**

   You have to hit the button/keystroke before the monitor even lights up, or this won't work.

   If it *does* work, you'll know it right away: The sound of the Chimes of Doom will fill your home or office.

   To get on with your life, restart the computer again normally.
(For most Macintosh models, Command-Control-Power button restarts the machine.)

The Easter Egg Hall of Classic Greats

We all know that a modem is a communications tool. But who knew it could actually speak?

Back when the original Apple Fax modem—circa 1988—was the rage, its owners could enjoy one of the world’s only spoken Easter eggs. If you turned the thing on while pressing the button on its face, the modem would beep three times. That’s your cue. If you pressed that front panel button three times, matching exactly the rhythm of the modem’s three beeps, you were rewarded by the modem’s speaking the first names of the engineers who designed it: “Peter . . . Alan . . . Neal.”
Chapter 9

Find Your Own Darned Easter Eggs

The sobering fact is that this book contains only the Easter eggs that have been found! The mind boggles to consider the dozens or hundreds that still lie undiscovered on our hard drives at this very moment.

After reading this book, you should be equipped to set out on your own Easter egg hunt with excellent prospects. Just remember the four most likely places to find lurking Easter eggs:
In the About Box

In almost every Mac program alive, the first command under the Apple menu is About Photoshop, or About ClarisWorks, or About... whatever-your-program's-name-is. It's a common hiding place for Easter eggs, particularly if you click in graphically significant places, and particularly if you're holding down various combinations of keys.

The Help screens are also good places to check.

In the Balloon Help

As noted in Chapter 4, you can't go wrong by choosing Show Balloons from the ? or Help menu on your screen and pointing to everything you see on the screen. The contents of your Extensions and Control Panels folders are especially ripe with potential, but funny or Easter egg-friendly balloon messages may lurk anywhere.
In the ResEdit Icons

Chapter 5 introduced you to the concept of prowling through software's guts using the free Apple program called ResEdit. Rooting around in the little resource icons is perfectly safe as long as you don't use the Save command, ever.

During Startup

A very few Easter eggs, such as the QuickTime slide show described in Chapter 1, are only accessible while the Mac is starting up, and only appear if you're holding down certain keys. These are tougher to stumble upon, of course, but so satisfying when you do!

What Next

Once you find new Easter eggs, by the way, your humble author stands ready to publish them and spread their (and your) fame—in future editions of this book, perhaps, or even in a sequel. Send
me E-mail at Internet address Pogue@aol.com, or send paper mail to me in care of the publisher.

Programmers of the world, thank you for taking the time and effort to bury so much treasure in your “real” work. But beware: Thousands of us will now be hounding you, sniffing out your Easter eggs, eager for more.

Get clever, programmers; we’re onto you.
David Pogue writes the back-page column for Macworld magazine. He's the author of several bestselling Macintosh books, including Macs for Dummies and Macworld Mac SECRETS; coauthor of a pair of music books, Opera for Dummies and Classical Music for Dummies; and writer of Hard Drive, a Macintosh techno-thriller from Ace Books. His other books in this series of small, funny Berkley computer books are The Microsloth Joke Book and Tales from the Tech Line.

E-mail: pogue@aol.com
Web page: www.pogueman.com
What Are Easter Eggs?

They're the secret surprises, games and graphics hidden inside your computer software. Who put them there? Subversive (or bored) programmers. How do you find them? Read this book....

The Great Macintosh® Easter Egg Hunt

Open—and play—the secret arcade game nobody knows about!

Get zapped by the fiendish QuarkXPress Martian!

Raise the hidden iguana flag—and salute!

Hunt the stately moose with the little-known "Antler!" command!

Hum along with the musical march of Monty Python's Flying Easter Egg!

Hear the infamous Chimes of Doom (without trashing your Mac)!

PLUS OODLES OF EASTER EGGS HIDDEN INSIDE:

Netscape • Photoshop • QuickDraw GX • AppleScript • ClarisWorks • FreeHand • RAM Doubler • StuffIt Deluxe • and much more!